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  Electronics (as defined above). 

Notes:  1." NEC Electronics" as used in this statement means NEC Electronics Corporation and also 
    includes its majority-owned subsidiaries. 

 2. " NEC Electronics products" means any product developed or manufactured by or for NEC 

The quality grade of NEC Electronics products is “Standard” unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in 
applications not intended by NEC Electronics, they must contact NEC Electronics sales representative in 
advance to determine NEC Electronics 's willingness to support a given application. 
 

 
   life support systems and medical equipment for life support, etc. 
"Specific":  Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems,  
 
   specifically designed for life support). 
   disaster systems, anti-crime systems, safety equipment and medical equipment (not 
"Special":  Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti- 

  equipment, audio and visual equipment, home electronic appliances, machine tools, 
  personal electronic equipment and industrial robots. 
 

"Standard": Computers, office equipment, communications equipment, test and measurement 
 

The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated “quality assurance program” for a specific application.  The recommended applications of NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality 
grade of each NEC Electronics product before using it in a particular application. 

 

・ NEC Electronics products are classified into the following three quality grades: “Standard”, “Special” 
and “Specific”. 

 

・ While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics 
products, customers agree and acknowledge that the possibility of defects thereof cannot be 
eliminated entirely.  To minimize risks of damage to property or injury (including death) to persons 
arising from defects in NEC Electronics products, customers must incorporate sufficient safety 
measures in their design, such as redundancy, fire-containment and anti-failure features. 

 

・ Descriptions of circuits, software and other related information in this document are provided for 
illustrative purposes in semiconductor product operation and application examples.  The incorporation 
of these circuits, software and information in the design of customer's equipment shall be done under 
the full responsibility of customer.  NEC Electronics no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.  

 

・ NEC Electronics does not assume any liability for infringement of patents, copyrights or other 
intellectual property rights of third parties by or arising from the use of NEC Electronics products listed 
in this document or any other liability arising from the use of such NEC Electronics products.  No 
license, express, implied or otherwise, is granted under any patents, copyrights or other intellectual 
property rights of NEC Electronics or others. 

 

・ No part of this document may be copied or reproduced in any form or by any means without prior 
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document. 

 

・ The information in this document is current as of date of its publication. The information is subject to 
change without notice. For actual design-in, refer to the latest publications of NEC Electronics data 
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products. Not all 
products and/or types are available in every country. Please check with an NEC sales representative 
for availability and additional information. 
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CAUTION 
 

This is a Test- and Measurement equipment with possibility to be significantly 
altered by user through hardware enhancements/modifications and/or test or 
application software. Thus, with respect to Council Directive 89/336/EEC 
(Directive on compliance with the EMC protection requirements), this equipment 
has no autonomous function. Consequently this equipment is not marked by the 
CE-symbol. 

EEDT-ST-0005-10 
 

 
 

 
Redemption of Waste Electrical and Electronic Equipment 
(WEEE) in accordance with legal regulations applicable in the 
European Union only: This equipment (including all 
accessories) is not intended for household use. After use the 
equipment cannot be disposed of as household waste. NEC 
Electronics (Europe) GmbH offers to take back the equipment. 
All you need to do is register at www.eu.necel.com/weee. 
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Regional Information 
 
Some information contained in this document may vary from country to country. Before using any NEC 
product in your application, please contact the NEC office in your country to obtain a list of authorized 
representatives and distributors. They will verify: 
 

• Device availability 
• Ordering information 
• Product release schedule 
• Availability of related technical literature 
• Development environment specifications (for example, specifications for 

third-party tools and components, host computers, power plugs, AC supply 
voltages, and so forth) 

• Network requirements 
 
In addition, trademarks, registered trademarks, export restrictions, and otherlegal issues may also vary 
from country to country. 
 
 
NEC Electronics Inc. (U.S.) 
Santa Clara, California 
Tel: 408-588-6000 
800-366-9782 
Fax: 408-588-6130 
800-729-9288 
 

NEC Electronics Hong Kong Ltd. 
Hong Kong 
Tel: 2886-9318 
Fax: 2886-9022/9044 
 

NEC Electronics (Europe) GmbH 
Duesseldorf, Germany 
Tel: 0211-65 03 0 
Fax: 0211-65 03 1327 
 

NEC Electronics Hong Kong Ltd. 
Seoul Branch 
Seoul, Korea 
Tel: 02-528-0303 
Fax: 02-528-4411 
 

Sucursal en España 
Madrid, Spain 
Tel: 091- 504 27 87 
Fax: 091- 504 28 60 
 

NEC Electronics Singapore Pte. Ltd. 
Singapore 
Tel: 65-6253-8311 
Fax: 65-6250-3583 
 

Succursale Française 
Vélizy-Villacoublay, France 
Tel: 01-30-67 58 00 
Fax: 01-30-67 58 99 
 

NEC Electronics Taiwan Ltd. 
Taipei, Taiwan 
Tel: 02-2719-2377 
Fax: 02-2719-5951 
 

Filiale Italiana 
Milano, Italy 
Tel: 02-66 75 41 
Fax: 02-66 75 42 99 
 

NEC do Brasil S.A. 
Electron Devices Division 
Guarulhos, Brasil 
Tel: 55-11-6465-6810 
Fax: 55-11-6465-6829 
 

Branch The Netherlands 
Eindhoven, The Netherlands 
Tel: 040-244 58 45 
Fax: 040-244 45 80 
 

 

Branch Sweden 
Taeby, Sweden 
Tel: 08-63 80 820 
Fax: 08-63 80 388 
 

 

United Kingdom Branch 
Milton Keynes, UK 
Tel: 01908-691-133 
Fax: 01908-670-290 
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1. Introduction 
78K0R - Cool it! is a demonstration kit for the NEC 78K0R 16-bit microcontroller family. It supports 
onboard debugging and real time execution of application programs. The board is prepared to be 
connected to user hardware parts such as digital I/O or analog signals. 

1.1 Main features of 78K0R – Cool it! 
• Easy to use device demonstration capabilities 

78K0R - Cool it! contains elements to easily demonstrate simple I/O-functions, i.e. navigator switch, 
16*2 LC display, I/O lines, analog inputs, UART serial interface etc. 

 
• On-Board debug function (TK-78K0R debugging) 

The 78K0R – Cool it! supports an On-Board debug function by using the IAR C-SPY debugger 
without a need of additional debug hardware. It allows FLASH downloading and standard debug 
functions like code execution, single stepping, breakpoints, memory manipulation etc. 

 
• 16*2 character LC display 

78K0R - Cool it! provides a 16*2 character LC display, allowing the implementation of human / 
machine interfaces, comfortable input / output functions, output of measurement values, output of 
status information etc.  

 
• Power supply by USB interface 
 
• Analog to digital signal conversion 
 
• Digital to analog signal conversion 
 
• Various input / output signals available, such as 
 

° I/O ports prepared to be connected to user hardware 
° 16*2 LCD display 
° Timer input / output signals 
° Two or three wire serial I/O 
° Virtual UART interface, via the µPD78F0731 78K0 8-bit microcontroller  

with on-board USB interface 
° 16 analog input lines 
° 2 analog output lines 
° Navigation switch prepared for key interrupt generation 
 

• The IAR Embedded Workbench for 78K0/78K0S/78K0R and the IAR C-SPY debugger / simulator are 
included. These packages are restricted in such that maximum program code size is limited to  
4 kByte. 

 
• Full documentation is included for the NEC 78K0R/KG3 microcontroller, IAR Systems Embedded 

Workbench and IAR Systems C-SPY debugger / simulator. 
 
 
 

78K0R - Cool it! is not intended for code development. NEC does not allow and does not support 
in any way any attempt to use 78K0R - Cool it! in a commercial or technical product. 

User’s Manual U18426EE1V0UM00                                                                       10 



78K0R - Cool it!  

1.2 System requirements 
 
HOST PC A PC supporting Windows 2000 or Windows XP is required for the IAR 

Systems Embedded Workbench demo-version and the 78K0R – Cool it! 
board. Pentium 200 MHz (at least), 128 MB of RAM, 256-color display 
(1024 * 768), mouse, CD-ROM drive and 200 Mbytes of free hard disk 
space are required to install the tool packages. 
 

Host interface USB interface that enables communication based on USB (Ver1.1 or 
later) 
 

1.3 Package contents 
Please verify that you have received all parts listed in the package contents list attached to the  
78K0R - Cool it! package. If any part is missing or seems to be damaged, please contact the dealer from 
whom you received your 78K0R - Cool it!. 
 
Note: Updates of the IAR Embedded Workbench for 78K, documentation and/or utilities for 78K0R - 

Cool it!, if available, may be downloaded from the NEC WEB page(s) at 
http://www.eu.necel.com/updates

 
 

1.4 Trademarks 
IAR Embedded Workbench, visualSTATE, IAR MakeApp and C-SPY are registered trademarks of IAR 
Systems AB. Microsoft and Windows are registered trademarks of Microsoft Corporation. Adobe and 
Acrobat Reader are registered trademarks of Adobe Systems Incorporated.  
 
All other product names are trademarks or registered trademarks of their respective owners. 
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2. 78K0R - Cool it! system configuration 
 
The 78K0R - Cool it! system configuration is given in the diagram below: 
 

 
 

Figure 1: 78K0R - Cool it! system configuration 

2.1 78K0R - Cool it! 

78K0R – Cool it! is a demonstration kit for the 78K0R/KG3 16-bit microcontroller of the 78K0R family. The 
demonstration board is connected to the host system via USB interface cable. The host system may be 
used for On-Chip debugging by using the IAR C-SPY debugger and to allow execution of application 
programs on 78K0R – Cool it! starterkit. 
 
78K0R - Cool it! runs the microcontroller at 20 MHz operating speed. The sub-clock is provided with 
32.768 kHz. 
 

2.2 Host computer 
The USB host interface enables communication to the 78K0R - Cool it! board. The µPD78F0731 78K0 
8-Bit microcontroller with on-chip USB interface and the NEC virtual UART driver allows application 
software to access the USB device in the same way as it would access a standard RS232 interface. The 
NEC virtual UART driver appears to the windows system as an extra Com Port, in addition to any existing 
hardware Com Ports.  
 

2.3 Power supply via USB interface 
The 78K0R - Cool it! is powered by the USB interface. Optional the power supply can be applied via 
connector J3.  
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3. 78K0R - Cool it! components 
 
The 78K0R - Cool it! board is equipped with a navigation switch, a 16*2 character LC display, LED’s and 
with several connectors in order to be connected to host computers, FLASH programmer or any external 
target hardware. 
 

 
 

Figure 2: 78K0R - Cool it! board connectors and switches 

 
Some of the 78K0R – Cool it! components are free for user application hardware and software. Please 
read the user’s manual of the 78K0R/KG3 device carefully to get information about the electrical 
specification of the available I/O ports before you connect any external signals to the 78K0R – Cool it! 
board. 
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3.1 Configuration switch SW2 
The different operation modes of the 78K0R - Cool it! board can be set by switch SW2/bit1-8.  
 

SW2/bit Factory settings Mode 
1 OFF Stand alone and debug Mode 
2 ON enable On-Board debug function 

(TK-78K0R debugging) 
3 ON enable On-Board debug function 

(TK-78K0R debugging) 
4 OFF TxD3 disconnected 
5 OFF RxD3 disconnected 
6 ON L_EVDD applied 
7 ON L_VDD applied 
8 ON L_AVREF0 applied 

Table 1: Configuration switch SW2, factory settings 

3.1.1 Stand alone / debug mode selection, SW2/bit1 
Switch SW2/bit1 controls the operation mode of the 78K0R - Cool it! board. By setting SW2/bit1 to OFF 
the 78K0R – Cool it! board is set to the “stand-alone mode”. Within this mode the RESET can be 
controlled by the user via switch SW3 and by the IAR C-SPY debugger. Within the stand-alone mode the 
user program stored in the internal FLASH memory of the 78K0R/KG3 microcontroller is executed. The 
usage of the On-Board debug function (TK-78K0R debugging) is also support within the “stand-alone 
mode”. 
 
By switching SW2/bit1 to ON the 78K0R – Cool it! board is set to the “debug mode” exclusively. Within 
this mode the 78K0R/KG3 device is permanently hold within RESET state. Only the IAR C-SPY debugger 
can control the RESET signal within this mode. The RESET switch SW3 is inactive. 
 
 

SW2/bit1 Mode 
OFF Stand alone and debug mode 
ON Debug mode only 

Table 2: Operation mode selection SW1/bit1 

 
Note:  After changing the configuration of SW2/bit1 it is necessary to power-up the 78K0R - Cool 

it! board to make changing active. This can be done by <plug and play> the USB interface 
cable. 

 

3.1.2 On-Board debug function (TK-78K0R debugging) selection, SW2/bit2-bit3 
SW2/bit2 and bit3 are controlling the On-Board debug function of the 78K0R – Cool it! board. By 
switching bits2 and 3 to ON the TK-78K0R debugging is enabled. In this mode a dedicated single-line 
UART (pin Tool0) of the 78K0R/KG3 is connected to the µPD78F0731 USB microcontroller. The Tool0 
pin of the 78K0R/KG3 microcontroller is reserved for on-board FLASH programming and debugging 
purpose. 
 
Switching bit2 and bit3 to OFF disconnects the single-line UART from the µPD78F0731 USB 
microcontroller. Within this mode no TK-78K0R debugging is supported. Use this mode in case you want 
to establish standard serial communication via UART3 to a terminal program running on the HOST PC. 
 
 

SW2/bit2 SW2/bit3 Mode 
OFF OFF Disable On-Board debug function  
ON ON Enable On-Board debug function 

Table 3: On-Board debug function (TK-78K0R debugging) selection, SW2/bit2-bit3 
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3.1.3 UART mode selection, SW2/bit4-bit5 
By switching bit4 and bit5 of SW2 to ON the UART3 signals RxD3 and TxD3 are connected to the 
µPD78F0731 USB microcontroller. Within this mode standard serial communication to a terminal program 
running on the HOST PC can be established. 
 
Switching bit4 and bit5 to OFF disconnects the UART3 serial lines from the µPD78F0731 USB 
microcontroller. 
 

SW2/bit4 SW2/bit5 Mode 
OFF OFF disconnect UART3 signals 
ON ON connect UART3 signals 

Table 4: UART mode selection, SW2/bit4-bit5 

 
 
 

3.1.4 L_EVDD control, SW2/bit6 
Switch SW2/bit6 controls the power supply (L_EVDD) for the LC display, LED1 and LED2. By switching 
bit6 to ON VDD is applied to L_EVDD. Switching bit6 to OFF disconnects the power supply for the output 
devices. 
 

SW2/bit6 Mode 
OFF L_EVDD disconnected 
ON L_EVDD = VDD 

Table 5: L_EVDD control, SW2/bit6 

 
 

3.1.5 L_VDD control, SW2/bit7 
Switch SW2/bit7 controls the power supply (L_VDD) for the digital logic of the 78K0R – Cool it! board. By 
switching bit7 to ON VDD is applied to L_VDD. Switching bit7 to OFF disconnects VDD. 
 

SW2/bit7 Mode 
OFF L_VDD disconnected 
ON L_VDD = VDD 

Table 6: L_VDD control, SW2/bit7 

 
 

3.1.6 L_AVREF0 control, SW2/bit8 
Switch SW2/bit8 controls the power supply (L_AVREF0) for the analog components – the operational 
amplifier LM324M – of the 78K0R – Cool it! board. By switching bit8 to ON VDD is applied to L_AVREF0. 
Switching bit8 to OFF disconnects VDD. 
 

SW2/bit8 Mode 
OFF L_AVREF0 disconnected 
ON L_AVREF0 = VDD 

Table 7: L_AVREF0 control, SW2/bit8 

 

User’s Manual U18426EE1V0UM00                                                                       15 



78K0R - Cool it!  

 

3.2 RESET button, SW3 
SW3 is the reset button. It activates the power on reset. Switch SW3 controls the reset input signal of the 
78K0R/KG3 microcontroller. 
 
 

3.3 Navigation switch, SW1 
Button SW1 is a navigation switch connected to the key interrupt input of the 78K0R/KG3 device. It 
operates in five directions including a center push function. The connection of SW1 is shown in the table 
below: 
 

SW1 Connection to the 
78K0R/KG3 device 

Left P72/KR2 
Down P74/KR4 
Select P71/KR1 
Right P73/KR3 
Up P70/KR0 

 
Table 8: Navigation switch SW1 

 

3.4 LED1 
LED1 is connected to I/O pin P145 / TI07 / TO07 of the 78K0R/KG3 microcontroller. A low signal output 
at this I/O pin switches the LED on. 
 

3.5 LED2 
LED2 is connected to I/O pin P46 / INTP1 / TI05 / TO05 of the 78K0R/KG3 microcontroller. A low signal 
output at this I/O pin switches the LED on. 
 

3.6 Power LED, LED3 
LED3 is the power LED of the 78K0R – Cool it! board. It indicates if power is applied to the 78K0R – Cool 
it! board. 
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3.7 Soldering bridges EVDD, AVREF0 and AVREF1 
Additional configuration of the 78K0R - Cool it! board can be done by the soldering bridges EVDD, 
AVREF0 and AVREF1. The different configuration modes are shown in the table below: 
 

EVDD
AVREF0 

AVREF1 
 

 

Figure 3: Soldering bridges EVDD, AVREF0 and AVREF1 

 

Soldering 
bridge 

Configuration Mode 

Closed (default) VDD connected to EVDD EVDD 
Open VDD disconnected from EVDD 
Closed (default VDD connected to AVREF0 pin AVREF0 
Open VDD disconnected from AVREF0 pin 
Closed (default) VDD connected to AVREF1 pin AVREF1 
Open VDD disconnected from AVREF1 pin 

Table 9: Soldering bridges EVDD, AVREF0 and AVREF1 

 

3.8 Analog reference voltage input, J2 
By using connector J2 (not assembled) different reference voltages can be applied to the A/D converter 
reference input pin AVREF0 and to the D/A converter reference input pin AVREF1 of the 78K0R/KG3 
microcontroller. 
 

J2 Input 
1 AVREF0 (A/D converter reference) 
2 AVREF1 (D/A converter reference) 

Table 10: Analog reference voltage input, J2 

 
Note: Before applying different reference voltages to the 78K0R – Cool it! board be sure to cut 

off the corresponding soldering bridges AVREF0 respectively AVREF1. 
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3.9 External power supply input, J3 
By using connector J3 (not assembled) external power supply can be applied to the 78K0R – Cool it! 
board without a need of an active USB connection.  
 

J3 Input 
1 VDD (+5V) 
2 GND 

Table 11: External power supply input, J3 

 
Note: Be sure to unplug the USB connection before applying external power supply to input J3. 
 

3.10 USB1 interface connector 
This interface allows connecting the IAR C-SPY debugger to the 78K0R - Cool it! board in order to use 
the On-Board debug function (TK-78K0R debugging). The TK-78K0R interface supports On-board 
FLASH erasing / programming and standard debug features like code execution, single stepping, 
breakpoints, memory manipulation etc. 
 
For standard communication to a host computer - i.e. by using a terminal program - the input/output 
signals of UART3 of the 78K0R/KG3 device can be redirected to the USB1 connector via the 
µPD78F0731 USB microcontroller. 
 
The power supply of the 78K0R - Cool it! board is also provided by the USB1 connector. 
 

1 5

 
Figure 4: Connector USB1, USB Mini-B Type Host Connector Pin Configuration 

 
 

Connector USB1 Signal Name 
1 VBUS 
2 D- 
3 D+ 
4 N.C. 
5 GND 

Table 12: Pin Configuration of Connector USB1 

 
For connection with the host machine, use a USB cable (Mini-B type). For confirmation, 
NEC Electronics used only the USB cable delivered with the 78K0R - Cool it! board. 
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3.11 PG-FP4 / QB-MINI2 connector FP1 
Connector FP1 (not assembled) allows connecting the PG-FP4 FLASH programmer to 78K0R - Cool it! 
board in order to program application software into the 78K0R/KG3 internal flash memory. Please note, 
the PG-FP4 FLASH programmer is a separate product from NEC and it is not included in this package. 
 
Additional FP1 allows connecting the QB-MINI2 On-Chip debug emulator to the 78K0R - Cool it! board in 
order to use On-Chip debug function of the 78K0R/KG3 device. Please note, QB-MINI2 is a separate 
product from NEC and it is not included in this starterkit package. 
 
 

FP1 Signal 
1 GND 
2 RESET 
3 SI 
4 VDD 
5 SO 
6 N.C. 
7 N.C. 
8 N.C. 
9 N.C. 
10 N.C. 
11 N.C. 
12 N.C. 
13 N.C. 
14 FLMD0 
15 RESET_IN 
16 CLK_IN 

Table 13: PG-FP4 / QB-MINI2 connector FP1 

 
When using PG-FP4 for FLASH programming or QB-MINI2 for debugging purpose, please configure 
switch SW2 of the 78K0R - Cool it! board as following: 
 

SW2 Setting Mode 
1 OFF Stand alone and debug mode 
2 OFF Disable On-Board debug function 
3 OFF Disable On-Board debug function 
4 ON/OFF (*) TxD3 connected / disconnected 
5 ON/OFF (*) RxD3 connected / disconnected 
6 ON L_EVDD applied 
7 ON L_VDD applied 
8 ON L_AVREF0 applied 

Table 14: Configuration of SW2 when using PG-FP4 or QB-MINI2 

 
(*) = individual selectable by user. 
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3.12 Display D1, 16*2 character LC display 
The 78K0R – Cool it! board is equipped with a character LC display. The alignment of the display is equal 
to 16 character words at 2 lines. The LCD module contains about a character generator ROM - including 
predefined standard characters - and a character RAM where the user can define its own characters. The 
display is connected to the 78K0R/KG3 device via three control lines and eight data lines. 
 
 

Display Pin Display Signal 78K0R/KG3 
I/O pin 

78K0R - Cool it! board 

1 RS0 P50 - 
2 RW P66 - 
3 E P65 - 
4 DB0 P80 - 
5 DB1 P81 - 
6 DB2 P82 - 
7 DB3 P83 - 
8 DB4 P84 - 
9 DB5 P85 - 

10 DB6 P86 - 
11 DB7 P87 - 
12 GND  GND 
13 VDD  L_EVDD 
14 V0  VR1 potentiometer arm 
15 F-GND  GND via capacitor C3 

Table 15: Display connections 

 
For more details about the LC display specification, commands and character table, please refer to the 
corresponding User’s Manual “ML9042.pdf” located in the /doc folder of the 78K0R – Cool it! CDROM. 
 

3.13 Potentiometer VR1 
The 10K potentiometer VR1 is connected between L_EVDD and ground. The potentiometer arm is 
connected to the V0 signal of the LCD module. It controls the operating voltage - contrast adjustment - of 
the LC display D1. 
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3.14 Connectors TPU10 – TPU29 and wrap field 
Several pins of the 78K0R/KG3 microcontroller are combined to the connectors TPU10 – TPU29. The 
corresponding assignment can be found in table below. Additional the 78K0R - Cool it! board provides a 
wire wrap field area allowing the integration of additional application hardware. 
 

 

wrap 
field 

 
 
 

Connector 78K0R/KG3 
I/O pin 

TPU10 P00 / TI00 
TPU11 P01 / TO00 
TPU12 P02 / SO10 / TXD1 
TPU13 P03 / SI10 / RXD1 / SDA1 
TPU14 P04 / SCK10 / SCL1 
TPU15 P05 / CLKOUT 
TPU16 P06 / WAIT 
TPU17 P10 / EX24 / SCK00 
TPU18 P11 / EX25 / SI00 / RXD0 
TPU19 P12 / EX26 / SO00 / TXD0 
TPU20 P75 / EX21 / KR5 / INTP9 
TPU21 P76 / EX22 / KR6 / INTP10 
TPU22 P77 / EX23 / KR7 / INTP11 
TPU23 P110 / ANO0 
TPU24 P111 / ANO1 
TPU25 P150 / ANI8 
TPU26 P151 / ANI9 
TPU27 P152 / ANI10 
TPU28 P153 / ANI11 
TPU29 P154 / ANI12 

Table 16: Connectors TPU10 – TPU29 
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3.15 Low-pass filter’s U1A, U1B and U1C 
The 78K0R – Cool it! board is equipped with three low-pass filter’s U1A, U1B and U1C, realized by the 
operational amplifier LM324M. Each input of a low-pass filter is connected to a dedicated timer output 
signal of the 78K0R/KG3 microcontroller. The corresponding output signal of a low-pass filter feeds a 
dedicated input of the A/D converter of the 78K0R/KG3 device. The corresponding assignment can be 
found in table below. 
 
 

Low Pass filter 78K0R/KG3 
I/O pin 

Input P16 / EX30 / TI01 / TO01 / INTP5 16-bit Timer01 output U1A 
Output P157 / ANI15 A/D converter input channel 15 
Input P17 / EX31 / TI02 / TO02 16-bit Timer02 output U1B 
Output P156 / ANI14 A/D converter input channel 14 
Input P31 / TI03 / TO03 / INTP4 16-bit Timer03 output U1C 
Output P155 / ANI13 A/D converter input channel 13 

Table 17: Low-pass filter’s U1A, U1B and U1C 
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4. On-Chip debugging 
The 78K0R - Cool it! board offers two possibilities to use On-Chip debugging (OCD). The TK-78K0R On-
Board debug function of 78K0R – Cool it! allows On-Chip debugging without a need of external debug 
hardware. Within this mode the default USB connection to the Host computer based on the virtual UART 
driver is used as debug interface. All standard debug functions are available in the On-Board debugging 
mode like FLASH programming / downloading, code execution, single stepping, breakpoints, memory 
manipulation etc. 
 
Additionally 78K0R – Cool it! supports the QB-MINI2 On-Chip debug emulator in order to use On-Chip 
debug function of the 78K0R/KG3 device. The system configuration for On-Chip debugging is shown in 
figure below. 

  
Figure 5: On-Chip debugging 

4.1 OCD via TK-78K0R On-Board debug function 
To operate the 78K0R - Cool it! board within the On-Board debug mode, configure switch SW2 as 
following: 
 
 

SW2 Setting Mode 
1 ON/OFF (*) Stand alone and debug mode / 

debug mode only 
2 ON Enable On-Board debug function 
3 ON Enable On-Board debug function 
4 OFF TxD3 disconnected 
5 OFF RxD3 disconnected 
6 ON L_EVDD applied 
7 ON L_VDD applied 
8 ON L_AVREF0 applied 

Table 18: OCD via TK-78K0R On-Board debug function 

(*) = individual selectable by user. 
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4.2 OCD via QB-MINI2 emulator 
To operate the 78K0R - Cool it! board together with the QB-MINI2 On-Chip debug emulator, configure 
switch SW2 as following: 
 

SW2 Setting Mode 
1 OFF Stand alone and debug mode 
2 OFF Disable On-Board debug function 
3 OFF Disable On-Board debug function 
4 ON/OFF (*) TxD3 connected / disconnected 
5 ON/OFF (*) RxD3 connected / disconnected 
6 ON L_EVDD applied 
7 ON L_VDD applied 
8 ON L_AVREF0 applied 

Table 19: OCD via QB-MINI2 emulator 

(*) = individual selectable by user. 
 
 
Note:  By supplying power from the QB-MINI2 do not connect external hardware to the 

78K0R - Cool it! board. Within this mode the 78K0R - Cool it! board can operate without 
external power supply from USB. 
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5. 78K0R/KG3 memory map 
 
The memory layout of 78K0R/KG3 device is shown in the figure below. 
 
 

 

 
                                                              Figure 6: 78K0R/KG3 memory map 

 
The 78K0R – Cool it! does not reserve any resources of the 78K0R/KG3 microcontroller, consequently all 
available memory of the device is free for application software. 
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6. 78K0R - Cool it! installation and operation 

6.1 Getting started 
The IAR Embedded Workbench including the C-SPY debugger allows to build and download application 
programs to the 78K0R - Cool it! starterkit. As communication interface between the PC host system and 
the 78K0R - Cool it! board a USB interface line is needed. Before you can download and run a program, 
software and hardware must be installed properly. 
 

6.1.1 CD-ROM contents 
The CD-ROM shows following directory structure: 
 

 78K0R – Cool it! (F:) CD-ROM ROOT 

  Acrobat - Acrobat Reader for 32Bit Windows OS 

  Doc - Documentation 

  IAR Embedded Workbench 78K0 - IAR Embedded Workbench for 78K0/78K0S/78K0R 

  SamplePrograms - Sample program for 78K0R – Cool it! 

   ADC_Demonstration  … AD Converter demonstration program 

   DMA_Demonstration  … DMA demonstration program 

   PWM_Demonstration  … PWM demonstration program 

   RTC_Demonstration  … Real-Time-Clock demonstration program 

   UART_Demonstration  … UART demonstration program 

Table 20: 78K0R - Cool it! CD-ROM directory structure  
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7. Hardware installation 
After unpacking 78K0R - Cool it!, connect the board to your host computer using the provided USB interface 
cable. When 78K0R - Cool it! is connected, the USB driver needs to be installed on the host machine. 
Please refer to the following CHAPTER 8 SOFTWARE INSTALLATION. 
 

8. Software installation 
The 78K0R - Cool it! package comes with the following software demo packages: 
 
• IAR Systems Embedded Workbench for 78K0/78K0S/78K0R, including C compiler, assembler, linker, 

librarian and IAR C-SPY debugger / simulator 
 
• Sample programs 
 
The IAR Systems Embedded Workbench must be installed on your PC. For detailed installation hints, refer 
to the following chapters and to the corresponding documentation of the IAR Embedded Workbench. 
 

8.1 IAR Systems Embedded Workbench for 78K0/78K0S/78K0R installation 
To install the IAR Systems Embedded Workbench for 78K0/K0S/K0R including C-SPY debugger / simulator, 
select the SETUP program in the directory \IAR Embedded Workbench 78K\ew78k\ of the CDROM. 
The setup dialogues will guide you through the installation process. 
 

8.2 Sample program installation 
To install the sample/demonstration program for the 78K0R – Cool it! board select the SETUP program in the 
directory \SamplePrograms\ of the CDROM. The setup dialogues will guide you through the installation 
process. 
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8.3 USB Driver Installation 
In order to use the 78K0R - Cool it! board for On-Chip debugging the USB driver needs to be 
installed on the host machine. Install the driver according to the following procedure: 

 
 

Installation on Windows 2000 ................  Page 28 
Installation on Windows XP ...................  Page 33 
 
 

           Note:  The USB driver is part of the IAR Embedded Workbench software package. Therefore 
                      please install the IAR Embedded Workbench first. 
 
 

8.3.1 Installation on Windows 2000 
 

1. When the 78K0R - Cool it! board is connected with the host machine, the board is 
recognized by <Plug and Play>, and the wizard for finding new hardware is started.  Click 
Next>. 

 

Figure 7: Found New Hardware Wizard (Windows 2000) 

 

Click.
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2. Following the window below is displayed. So, check that "Search for a suitable driver ..." is 
selected, then click Next>. 

 

Figure 8: Search Method (Windows 2000) 

 

Check that "Search for a 
suitable driver ..." is selected. 

Click. 

 
 
 
 
 

3. Check the "Specify a location" check box only, then click Next>. 
 

Figure 9: Driver File Location (Windows 2000) 

 

Check that "Specify a 
location" only is checked. 

Click. 
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4. Locate to the folder "C:\Program Files\IAR Systems\Embedded Workbench 

4.0\78K\config\nec\ie_pc_driver\MINICUBE”. 
 

Figure 10: Address Specification 1 (Windows 2000) 

 
 
 

Locate to “C:\Program Files\IAR Systems\Embedded Workbench 
4.0\78K\config\nec\ie_pc_driver\MINICUBE” 

 
 
 
 

Remark If the installation destination folder is changed at the time of IAR Embedded 
Workbench installation, enter "new-folder\78K\config\nec\ie_pc_driver\MINICUBE". 

 
 

5. The setup information file “MQB2ALL.inf” is automatic selected, then click Open to proceed 
within driver installation. 

 

Figure 11: Address Specification 2 (Windows 2000) 

 

Click.
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6. After the location of the USB driver has been specified click OK to proceed. 

 

Figure 12: Address Specification 3 (Windows 2000) 

 

Click.

 
 
 

5. Click Next>. 
 

Figure 13: Driver File Search (Windows 2000) 

 

Click.
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6. Click Finish to complete the installation of the USB driver. 

 

Figure 14: USB Driver Installation Completion (Windows 2000) 

 

Click. 
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8.3.2 Installation on Windows XP 
 

1. When the 78K0R - Cool it! board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for finding new hardware is started. At first 
the hardware wizard will ask if windows should search on the windows update web, 
check "No, not this time" and then click Next>. 

 

Figure 15: Found New Hardware Wizard 1 (Windows XP) 

 

Check that "No, not this time" 
is selected. 

Click.

 

 

 
2. Check that "Install from a list or specific location (Advanced)" is selected, then click 

Next>. 
 

Figure 16: Found New Hardware Wizard 2 (Windows XP) 

 

Check that "Install from a list or 
specific ..." is selected. Click. 

 

 

 

User’s Manual U18426EE1V0UM00                                                                       33 



78K0R - Cool it!  
 

3. Check that "Search for the best driver in these locations." is selected. Select the "Include 
this location in the search:" check box and then click Browse. 

 

Figure 17: Search Location Specification 1 (Windows XP) 

 

<1> Check that "Search for the 
best driver in these locations." 
is selected. 

<2> Check "Include this 
location in the search:" 
only. 

<3>  Click. 

 
 
 

4. Locate the folder "C:\Program Files\IAR Systems\Embedded Workbench 
4.0\78K\config\nec\ie_pc_driver\MINICUBE” and click OK. 

 

     Figure 18: Search Location Specification 2 (Windows XP) 

 

Click. 

 
Remark If the installation destination folder is changed at the time of IAR Embedded 

Workbench installation, enter "new-folder\78K\config\nec\ie_pc_driver\MINICUBE". 
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5. After the location of the USB driver has been specified click Next> to continue driver 
installation. 

 

Figure 19: Search Location Specification 3 (Windows XP) 

 

Click. 

 
 
 
 

6. As shown below, "NEC Electronics Starter Kit Virtual UART has not passed Windows 
Logo testing to verify its compatibility with Windows XP." is displayed. Click Continue 
Anyway. 

 

Figure 20: Windows XP Logo Testing (Windows XP) 

 

Click.
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7. After the installation of the USB driver is completed the window below is displayed. Click 
Finish to close the hardware wizard. 

 

Figure 21: USB Driver Installation Completion (Windows XP) 

 

Click. 
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8.4 Confirmation of USB Driver Installation 
 
After installing the USB driver, check that the driver has been installed normally, according to 
the procedure below. When using the 78K0R - Cool it! board in combination with IAR C-SPY 
debugger the “NEC Electronics Starter Kit Virtual UART” should be present like in the figure 
below. 

 
 

By choosing the "Device Manager" within the Windows Properties (“Hardware” tab), check that 
the driver is installed normally. 

 

Figure 22: Device Manager 

               

Check that "NEC Electronics 
Starter Kit Virtual UART (COM?)" 
is present. 
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9. IAR sample session 
When everything is set up correctly the IAR Embedded Workbench can be started. To do so, start the 
Embedded Workbench from Windows “Start” menu > “Programs” > folder “IAR Systems” > “IAR Embedded 
Workbench Kickstart for 78K”. The following screen appears: 
 

 
Figure 23: IAR Embedded Workbench 

 
Now select the option “Open exiting workspace” from the “File” menu and locate the sample project. Open 
the file “78K0R_Coolit.eww”. This is the workspace file that contains general information about the demo 
projects and corresponding settings. 
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After the demo workspace has been opened the files contained in the workspace are displayed. Now click 
on the little “+” sign next to the project filename “ADC_demo - Debug” to show all files that were part of the 
selected demonstration project. The screen should now look similar to this: 
 

  
Figure 24: IAR project workspace 

 
As a next step check some settings of the IAR Embedded Workbench that have to be made for correct 
operation and usage of the On-Board debug function of the 78K0R – Cool it! board. First highlight the upper 
project folder called “ADC_demo – Debug” in the workspace window. Then select “Project” > “Options” from 
the pull-down menus. Next select the category “Debugger”. Make sure that the driver is set to “TK-78” in 
order to use the On-Board debug function of the 78K0R – Cool it! board. The device description file must be 
set to “io78f1166_a0.ddf”. The corresponding COM port where the 78K0R – Cool it! board is connected to 
the host PC will be detected automatically by the IAR C-SPY debugger. 
 

Select “TK-78” to 
use On-Board 
debugging. 

Check that device 
description file of 
µPD78F1166 is 
selected. 

 
Figure 25: IAR debugger options 
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Next the correct linker settings of the demo project will be checked. This can be done in the “Linker” 
category as shown below. Select the “Config” tab and check that the linker command file 
“lnk78f1166_a0.xcl” is selected. This file is used by the linker and contains information on where to place the 
different sections of code, data and constants that may be used within the demo project: 
 

 
Figure 26: IAR Linker options 

 
Now after everything has been setup correctly it’s time to compile and link the demonstration project. Close 
the Options menu and select “Rebuild All” from the “Project” menu. If the project is compiled and linked 
without errors or warnings it can now be downloaded to the 78K0R – Cool it! board and debugged. To start 

the IAR C-SPY debugger select the option “Debug” from the “Project” menu or press the ( ) “Debugger” 
button. In the next step the TK-78 Emulator has to be configured before downloading a new application. 
Press the OK button to enter the emulator hardware setup. Set the configuration as show in the figure below 
and start the download by pressing the OK button. 
 

 
              Figure 27: TK-78 hardware setup menu 
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Now the debugger is started and the demo project is downloaded to the 78K0R – Cool it! board. The 
progress of downloading is indicated by blue dots in the TK-78 Emulator window. Please note, downloading 
of larger executables can take some time. 
 

 

 
         Figure 28: IAR project download 
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After the download was completed all debug features of IAR C-SPY debugger are available, i.e. Single 
Stepping, Step Over/-In/-Out, Go-Execution, Breakpoints, Register / Memory view etc. 
 
To get more details on the debugger configuration and capabilities please refer to the “78K IAR Embedded 
Workbench IDE User Guide” of the IAR installation. 
 

 
Figure 29: IAR C-SPY debugger 

 
 

10. Troubleshooting 
In some cases it might happen that the connection to the 78K0R – Cool it! can not be established. This can 
be caused by the following two situations: 
 

• Wrong security ID: The security ID is required to prevent the FLASH memory of the 78K0R/KG3 
microcontroller from being read by an unauthorized person. The security ID is located in the internal 
flash memory at addresses 0xC4-0xCD of the 78K0R/KG3 microcontroller. The IAR C-SPY 
debugger starts only when the security ID that is set during debugger start-up and the security ID 
set at addresses 0xC4 to 0xCD do match. 
 

• Disabled On-Chip debug: The On-Chip debug function of the 78K0R/KG3 microcontroller can be 
controlled by a dedicated Option Byte located at address 0xC3 in the internal flash memory. By 
disabling the On-Chip debug operation no connection to device can be established neither using the 
TK-78 interface nor using the QB-MINI2 On-Chip debug emulator. 

 
In the above mentioned cases it is necessary to erase the internal flash memory of the 78K0R/KG3 
microcontroller to restore the security ID and to enabled the On-Chip debug function. 
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In case of a security ID mismatch the following message box is displayed by the IAR C-SPY debugger. Click 
the YES button to enter the Hardware Setup menu. 

Click

 
Figure 30: TK-78 enter Hardware Setup 

 
Specify the default security ID <1> - the default security ID of an erased flash is equal to 10bytes 0xFF each 
-and enable the “erase flash before next ID check” option <2>. Then press the OK button <3> to start flash 
erasing and to establish the debugging session. 
 
 

 

<1> specify default 
security ID

<2> enable erase flash 
        before next 
        ID check 

<3> Click

 
Figure 31: TK-78 Hardware Setup menu 

 
The progress of flash erasing is indicated by blue dots in the TK-78 Emulator window. Following the 
debugger starts downloading the executable to the 78K0R – Cool it! board like shown in figure 28. 
 
 

 
Figure 32: TK-78 flash erasing 
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11. Sample programs 

11.1 General Introduction 
Each of the sample programs is located in a single directory, which will be called main-directory of the 
sample. This main directory of each sample contains the complete project inclusive all output files of the 
development tool. The workspace file “78K0R_Coolit.eww” is located on top of the sample program 
directories. All sample programs use the same directory structure: 
 
 

 ADC_Demonstration 78K0R/KG3 project and output files 

  Debug  debug output files for IAR C-SPY debugger 

  inc  C header files 

  Release  release output files, i.e. Intel HEX file 

  settings  configuration files, IAR Embedded Workbench 

  source  C source files 

  xcl  Linker control file 

  ADC_demo.dep  dependency information file, IAR Embedded Workbench 

  ADC_demo.ewd  project setting file, IAR C-SPY debugger 

  ADC_demo.ewp  project file, IAR Embedded Workbench 

 DMA_Demonstration 78K0R/KG3 project and output files 

 PWM_Demonstration 78K0R/KG3 project and output files 

 RTC_Demonstration 78K0R/KG3 project and output files 

 UART_Demonstration 78K0R/KG3 project and output files 

 78K0R_Coolit.eww workspace file, IAR Embedded Workbench 78K0/78K0S/78K0R 

Table 21: Example directory structure 

 
The main directory contains only the project files for the IAR Systems Embedded Workbench 
78K0/78K0S/78K0R. All source files are located in the directory /source and the /inc directory contains 
the header files. The /xcl directory contains the linker control file of the 78K0R/KG3 device. Each sample 
project uses two targets. One target is the “Debug” (directory /Debug) that holds all information for 
debugging purpose and the other one the “Release” target (directory /Release) contains the programmable 
file, i.e. the Intel HEX file, for programming the 78K0R/KG3 internal FLASH memory via PG-FP4. 
 
All output files of the development tools for the corresponding target are generated in the directories /Debug 
and /Release. 
 
For details of using the IAR Embedded Workbench and the IAR C-SPY debugger please refer to the “78K 
IAR Embedded Workbench IDE User Guide”. 
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11.2 ADC demo 
This sample program demonstrates the usage of the A/D converter. After button SW1 is pressed three 8-bit 
PWM's are generated by using the plural channel mode of the Timer array unit. The PWM's were feeding the 
three low-pass filter's U1A, U1B, U1C. The PWM's were modulated every 50us triggered by Timer channel 5 
interrupt signal. Based on the amount of four hundred interpolations the generation of a 50Hz sinus wave is 
simulated. By pressing SW1, the Timer channel 5 is stopped and the actual voltage level can be measured. 
Using the up/down directions of SW1 the PWM duty cycle can be modified and the output voltage of the 
selected low-pass filter U1A, U1B or U1C is measured again. The selection of the output voltage channel 
can be done by using the left/right direction of SW1. The sinus wave generation is restarted by pressing 
SW1. 
 

11.3 DMA demo 
This sample program demonstrates the usage of the DMA controller. After the program is started press 
button SW1 to start DMA transfer. The DMA is trigger by Timer channel 1 every 100 ns. After 52 bytes are 
transferred to the D/A converter channel 0 and 1, the DMA is re-initialized within the DMA interrupt service 
routine. The analog output values can be measured using the connectors TPU23 and TPU24. 
 

11.4 PWM demo 
This sample program demonstrates the generation of a 8-bit and 16-bit PWM by using the Timer array unit. 
After the program is started press button SW1 to start the PWM demonstration. The Timer channels 4 and 5 
are used for the generation of the 16-bit PWM and the Timer channels 6 and 7 for the generation of the 8-bit 
PWM. The duty cycles of the PWM's can be changed by using the up/down direction of the navigation switch 
SW1. By pressing SW1 the increment respectively decrement of the duty cycle is stopped. The 8-bit PWM 
controls the lighting intensity of LED1 and the 16-bit PWM controls LED2. By using the left/right direction of 
the navigation switch SW1 the minimum / maximum duty cycle can be set. 
 

11.5 RTC demo 
This sample program demonstrates the usage of the real time counter. After the program is started press 
button SW1 to start RTC demonstration. By using the navigation switch SW1 the following Menus can be 
selected: 
 

** 78K0R/KG3 **
** Cool-it! **

** RTC Demo **
1. Display Clock

** RTC Demo **
2. Set Clock   

** RTC Demo **
3. Set Alarm   

Su 16-Oct-06
12:00:00 AM

Su 16-Oct-06
12:00:00 AM
S

SuMoTuWeThFrSa
◄ . . . . . . . ►

Set Alarm Time
◄ 12:00:00 AM2

** 78K0R/KG3 **
** Cool-it! **

** RTC Demo **
1. Display Clock

** RTC Demo **
2. Set Clock   

** RTC Demo **
3. Set Alarm   

Su 16-Oct-06
12:00:00 AM

Su 16-Oct-06
12:00:00 AM
S

SuMoTuWeThFrSa
◄ . . . . . . . ►

Set Alarm Time
◄ 12:00:00 AM2

→ Setup of alarm 
weekday and alarm 
time 

 
 

 
 
 
 
 
 

→ Displays actual date 
and time 

 
 
 

→ Setup of date, time and 
clock mode (24h or 
AM/PM mode) 

 
 
A menu can be selected by using the up/down direction of SW1. The corresponding menu point can be 
entered and left by pressing SW1. Changing of date, time, clock mode, alarm weekday and alarm time is 
done by using the up/down direction of navigation switch SW1. 
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11.6 UART demo 
This sample program demonstrates the initialization and usage of the UART3 by using the Serial array unit 1, 
channel 2 and 3. After the program is started press a key on the terminal program that is running on your 
host system. 
 
Because the TK-78K0R debugging interface and the UART3 are sharing the same virtual COM port, please 
close the IAR C-SPY debugger after the sample program has been downloaded to the 78K0R - Cool it! 
board. Unplug the USB interface and switch SW2 bits 1,2,3 to OFF and bits 4,5,6,7,8 to ON to allow 
communication via UART3. 
 
Plug the USB interface and open a terminal program. Configure the serial com port of your terminal program 
as following and press the reset button SW3 to restart the sample program. 
 

Serial COM Port configuration 
Baud rate: 9600 
Data: 8-bit 
Parity: None 
Stop: 1-bit 
Flow control: None 
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12. Cables 
 

12.1 USB interface cable (Mini-B type) 
 

 
Figure 33: USB interface cable (Mini-B type) 

User’s Manual U18426EE1V0UM00                                                                       47 



78K0R - Cool it!  

13. Schematics 

 
Figure 34: 78K0R - Cool it! schematics 1/2

User’s Manual U18426EE1V0UM00                                                                       48 



78K0R - Cool it!  

 

Figure 35: 78K0R - Cool it! schematics 2/2
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[MEMO] 
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